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Chapter 4 Subsectioning

Sonnet のｻﾌﾞｾｸｼｮﾝ (分割）は project editorの画面に小さなﾄﾞｯﾄ (点）で表示
される均一なﾒｯｼｭからできています。小さなﾄﾞｯﾄは１つの “ ｾﾙ ”の四隅
に置かれます。１つ以上のｾﾙを自動的に結合してｻﾌﾞｾｸｼｮﾝを作ります。
ｾﾙは正方形か長方形 (縦横比は自由）ですが、回路全体に渡って同じで
なくてはなりません。ｾﾙｻｲｽﾞは  project editor の Box Settings ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽ
（これは Circuit ⇒ Boxを選択すると表示されます）の中で設定されま
す。解析はそれぞれのｻﾌﾞｾｸｼｮﾝの電流を解きます。複数のｾﾙはまとまっ
て１つのｻﾌﾞｾｸｼｮﾝになるので、ｻﾌﾞｾｸｼｮﾝの数はふつうｾﾙの数より相当少
なくなります。これは重要なことです。というのは解析では N x N の行
列（ここで N はｻﾌﾞｾｸｼｮﾝの数）を解くからです。  N の値が小さければ解
析時間とﾒﾓﾘが大幅に少なくてすみます。

正確さが損なわれないようにするため、ｾﾙをｻﾌﾞｾｸｼｮﾝにまとめることに
注意が必要です。Emは自動的に電流密度が急峻に変わるｸﾘﾃｨｶﾙな領域に
は小さなｻﾌﾞｾｸｼｮﾝを配置します。しかし、電流密度がなめらかで変化が
ゆるやかなあまりｸﾘﾃｨｶﾙでない領域には大きなｻﾌﾞｾｸｼｮﾝを配置します。
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しかし場合によっては、自動ｱﾙｺﾞﾘｽﾞﾑを修正したくなるでしょう。とい
うのは、より速く、つまり精度を要求されない場合や、より遅く、つま
り精度の高い場合には自動ｱﾙｺﾞﾘｽﾞﾑで与えられる以上のことを行ないた
くなるからです。また、回路について作成者が知識を持っていても、
ﾌﾟﾛｸﾞﾗﾑの方にはこれがないこともあるでしょう。例えば、金属導体の
ある領域には電流はほとんど流れないということを、作成者の方はわ
かっている時などです。または、回路で寸法が小さいので小さいｾﾙを指
定したが、その回路に大きな構造体があって、正確な小さなｾﾙは必要な
いという時もあるでしょう。そうした場合には、emがｾﾙをまとめて
ｻﾌﾞｾｸｼｮﾝにする方法を変えることができます。

この章では emがｾﾙをまとめてｻﾌﾞｾｸｼｮﾝにする方法と、必要とする解析
時間や精度のﾚﾍﾞﾙを得るためにどのようにｺﾝﾄﾛｰﾙできるかを説明しま
す。ｾﾙｻｲｽﾞの選び方やそれが emの解析にどう影響するかについても述
べます。

ｺﾝﾌｫｰﾏﾙﾒｯｼｭは長い斜め線や縁部が曲線の図形をﾓﾃﾞﾘﾝｸﾞするのに使われ
るｻﾌﾞｾｸｼｮﾝの特別な例です。ｺﾝﾌｫｰﾏﾙﾒｯｼｭ機能を使用する時の
ｻﾌﾞｾｸｼｮﾆﾝｸﾞについての詳細は、69 ﾍﾟｰｼﾞの “Conformal Mesh 
Subsectioning”をご覧ください。

Tips for Selecting A Good Cell Size
ご存知のように emは、project editorでつくられる基本のﾌﾞﾛｯｸである
“ ｾﾙ ”によってできているｻﾌﾞｾｸｼｮﾝ単位に回路を小さく分割します。次に
ｾﾙｻｲｽﾞの決め方について説明します。また、 Sonnet の Cell Size Calculator 
を使用すれば、要求される精度を提供する最も効率のよいｾﾙｻｲｽﾞを計算
するために重要な寸法を入力することができます。 Cell Size Calculator は
project editorのﾒｲﾝﾒﾆｭｰから Circuit ⇒ Boxを選択した時にｵｰﾌﾟﾝする Box
Settings ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽから利用します。

TIP
ｾﾙｻｲｽﾞは波長の 1/20 より小さくします。
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ｾﾙｻｲｽﾞを計算する前に最高の解析周波数の波長を計算することが大切で
す。正確な数が大切なのではありません。もし、作成した回路の有効な
比誘電率を知っていれば、それを波長の計算に使用してください｡もし
知らなければ作成した構造体の最も高い比誘電率を使用してください｡

多くの回路では波長の 1/20 以下のｾﾙｻｲｽﾞを必要とします。より大きな
ｾﾙｻｲ ｽﾞを選んでも、大抵、ｾﾙに渡って分布する効果が不正確にﾓﾃﾞﾘﾝｸﾞ
されてしまうので、容認できないｴﾗｰとなってしまいます。波長の 1/20 
以下のｾﾙ ｻｲｽﾞは少し精度が上がりますが、大抵はｻﾌﾞｾｸｼｮﾝの数の総数が
増え、そのために解析時間と必要ﾒﾓﾘが増えてしまいます。

TIP
可能な時は、回路の寸法を丸めてください｡そうすればより大きい公倍
数がとれます。

回路の図形が一番近いｾﾙにｽﾅｯﾌﾟされるので、回路の全寸法がこの
ｾﾙｻｲｽﾞの倍数になるようにｾﾙｻｲｽﾞを決めなくてはなりません。例えば回
路の寸法が 30 ﾐｸﾛﾝ、40 ﾐｸﾛﾝ、 60 ﾐｸﾛﾝだとすると、考えられるｾﾙｻｲｽﾞは 10
ﾐｸﾛﾝ、 5 ﾐｸﾛﾝ、 2.5 ﾐｸﾛﾝ、 2 ﾐｸﾛﾝなどです。ｾﾙｻｲｽﾞが大きいとより効率的な
解析ができるのでここでは 10 ﾐｸﾛﾝが一番よいｾﾙｻｲｽﾞとなるでしょう。

TIP
X方向のｾﾙｻｲｽﾞと Y方向のｾﾙｻｲｽﾞは別々に計算します。

X方向のｾﾙｻｲｽﾞとY方向のｾﾙｻｲｽﾞは同じ大きさである必要はありません。
回路の X方向の寸法に基づいて X方向のｾﾙｻｲｽﾞを、Y方向の寸法に基づ
いて Y方向のｾﾙｻｲｽﾞを計算します。例えば幅が 3 ﾐｸﾛﾝ、線間が 8 ﾐｸﾛﾝの
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ｽﾊﾟｲﾗﾙｲﾝﾀﾞｸﾀの場合、 3 ﾐｸﾛﾝを  4  ﾐｸﾛﾝに直してください｡ここで 8のかわ
りに 2 ｾﾙ を使うと回路の性能には少しも影響を与えずに解析速度を数倍
上げることができます。この考え方を下図に示します。

2つの回路は金属導体の量は同じにもかかわらず、回路１の方が回路 2よ
りも解析時間が多くかかり、ﾒﾓﾘも多く必要です。これは、回路 2では
寸法を 4で割っているので、ｾﾙｻｲｽﾞは 4 ﾐｸﾛﾝが使われます。回路１には
１ﾐｸﾛﾝのｾﾙ ｻｲｽﾞが必要となります。寸法を変えることによる回路への響

Circuit 1:
Requires 80 cells

Circuit 2:
Requires only 6 cells
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や製作上の許容誤差について考えてください｡回路がもし１ﾐｸﾛﾝ変えて
も問題ないとか、許容誤差は +/- 1 ﾐｸﾛﾝだけというのなら、回路１の 3 ﾐ
ｸﾛﾝをとって回路 2のように 4 ﾐｸﾛﾝにすることができます。

Cell Size Calculator

Sonnet にはまた Cell size calculator という機能があり、ﾕｰｻﾞの回路の
ｸﾘﾃｨｶﾙな寸法をもとに最適なｾﾙｻｲｽﾞを計算します。(Circuit ⇒ Boxを選択
した時にｵｰﾌﾟﾝする）Box Settings ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの Cell Size Calculator で使
用できます。 Cell Size Calculator の使用方法は Sonnet Tutorialの第 4章
"Determining Cell Size"で説明されています。 Cell Size Calculatorのすべての
入力項目については、ｵﾝﾗｲﾝﾍﾙﾌﾟをご覧ください。

Viewing the Subsections
以下の指示に従うと、Sonnetで使用されているｻﾌﾞｾｸｼｮﾝを見ることがで
きます。 Estimate Memory ｺﾏﾝﾄﾞを使用する前に、誘電体層が定義され、
少なくとも 1つのﾎﾟｰﾄが回路になくてはならないことをご承知おきくだ
さい。

ｻﾌﾞｾｸｼｮﾆﾝｸﾞを表示するには、以下のようにします。

1 Project editorから Analysis => Estimate Memoryを選択します。

これで解析に必要なﾒﾓﾘ数が計算されます。
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2 View Subsections ﾎﾞﾀﾝをｸﾘｯｸします。

回路の図が表示されます。下図のように、金属は赤色、ｻﾌﾞｾｸｼｮﾝの境が
黒い線で表示されます。

Subsectioning and Simulation Error
上述したように、 Sonnet は一定の分解能のｸﾞﾘｯﾄﾞを使い、所定の金属導
体のﾊﾟﾀｰﾝを、ﾍﾞｰｽ となるｸﾞﾘｯﾄﾞで離散化します。 Sonnet はｸﾞﾘｯﾄﾞ上にあ
る金属の充填部だけｼﾐｭﾚｰﾄしますが、設計物の金属ﾊﾟﾀｰﾝの縁は、
ｸﾞﾘｯﾄﾞに位置合わせする必要はありません。ｸﾞﾘｯﾄﾞから離れた金属導体
は、ｸﾞﾘｯﾄﾞと金属ﾊﾟﾀｰﾝとのずれの度合いによっては充填がはみ出たり、
少なかったりするかもしれません。Sonnet のｼﾐｭﾚｰｼｮﾝでは、ずれがある
と誤差を生じる可能性があることを表示して知らされますが、どの
ﾌﾟﾚｰﾅ (平面) ﾓｰﾒﾝﾄ法 (MoM)のｼﾐｭﾚｰｼｮﾝにも誤差の要因は複数含まれて
います。

 Sonnetとは違って、大抵の電磁界ｿﾌﾄｳｪｱのﾍﾞﾝﾀﾞｰは、誤差の要因につい
てはあまり語りません。(401 ﾍﾟｰｼﾞの "Accuracy Benchmarking "をご覧下
さい）。 Sonnetでは、所望の金属ﾊﾟﾀｰﾝとｼﾐｭﾚｰｼｮﾝのｸﾞﾘｯﾄﾞにずれがある

金属導体

急激に電流密度が変化
する領域が、より小さ
なｻﾌﾞｾｸｼｮﾝになること
にご注意下さい。

ｻﾌﾞｾｸｼｮﾝの境
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という事実は必ずしも Sonnet のｼﾐｭﾚｰｼｮﾝが、無限の分解能でﾒｯｼｭを行
う、競合のｼﾐｭﾚｰﾀよりも精度が劣ることを意味するものではありませ
ん。どのｼﾐｭﾚｰｼｮﾝ･ﾊﾟｯｹｰｼﾞも誤差を生じる可能性をすべて (使用される
MoM技法によって異なります )調べ、十分収束したﾃﾞｰﾀｾｯﾄに達してい
るか確かめるべきです。

Changing the Subsectioning of a Polygon
Sonnet では、図形毎にｾﾙの分割される方法をｺﾝﾄﾛｰﾙすることができま
す。それにはﾊﾟﾗﾒｰﾀ “X Min”、 “Y Min”、 “X Max” 、 “Y Max”を使います。
これらのﾊﾟﾗ ﾒｰﾀは図形毎に変えることができますので、ある図形には粗
いｻﾌﾞｾｸｼｮﾝ、ある図形には細かいｻﾌﾞｾｸｼｮﾝができます。このﾊﾟﾗﾒｰﾀの変
え方については、  project editorのｵﾝﾗｲﾝﾍﾙﾌﾟの “Modify - Metal Properties”
をご覧ください。

これらのﾊﾟﾗﾒｰﾀをどのように利用するかについて述べる前に、emでは
ﾃﾞﾌｫﾙ ﾄのﾊﾟﾗﾒｰﾀ値で図形が自動的に分割されることをまず理解しなくて
はなりません。

Default Subsectioning of a Polygon

ﾃﾞﾌｫﾙﾄでは、Sonnetは "階段状 " ｻﾌﾞｾｸｼｮﾝで図形を充填します。他には、
より上級な充填の種類 (斜め線とｺﾝﾌｫｰﾏﾙ ) がこのﾏﾆｭｱﾙの他の章で説明
されています。斜め線状のｻﾌﾞｾｸｼｮﾝについては 297 ﾍﾟｰｼﾞの第 17章
"Using Diagonal Fill”をご覧下さい。ｺﾝﾌｫｰﾏﾙﾒｯｼｭについては 169 ﾍﾟｰｼﾞの第
11章 "Conformal Mesh"をご覧下さい。この章ではもっぱら階段状
ｻﾌﾞｾｸｼｮﾝについてのみ説明します。
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下図のように小さな矩形のｻﾌﾞｾｸｼｮﾝを使って、斜め線状の縁を近似させ
ると、実際の金属導体は階段の形に見えるので、この充填の種類を階段
といいます。

ｻﾌﾞｾｸｼｮﾝのﾊﾟﾗﾒｰﾀ値はﾃﾞﾌｫﾙﾄ設定では、X Min = 1、 Y Min = 1、X Max = 100 、 Y 
Max = 100になっています。この数字は、図形で可能なｻﾌﾞｾｸｼｮﾝの最小及び最大
の寸法を表わします。 X Min = 1にすると、 X 方向の最小ｻﾌﾞｾｸｼｮﾝｻｲｽﾞは 1 ｾﾙの大
きさになります。X Max = 100にすると、ｻﾌﾞｾｸｼｮﾝの長さが 100 ｾﾙ以上というの
は許されません。

下図では、ﾃﾞﾌｫﾙﾄ設定されているｻﾌﾞｾｸｼｮﾝのﾊﾟﾗﾒｰﾀ値がどのように使われてい
るかを示しています。角部ではｻﾌﾞｾｸｼｮﾝのｻｲｽﾞがたった 1 ｾﾙになっていることに
ご注意ください｡電流密度がここでは最も早く変わりますので、可能な限り小さ
いｻﾌﾞｾｸｼｮﾝｻｲｽﾞが使われています。

黒の輪郭はﾕｰｻﾞが入力した図形
です。模様表示されている面
は、emで解析された実際の金属
導体です。

階段状の縁
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回路の縁に沿って、角部から離れるに従ってｻﾌﾞｾｸｼｮﾝのｻｲｽﾞは長くなります。例
えば角部から 2個めのｻﾌﾞｾｸｼｮﾝは 2 ｾﾙ分の長さでその次のｻﾌﾞｾｸｼｮﾝは 4 ｾﾙ分の長
さになります。もし、回路の端の長さが十分長ければｻﾌﾞｾｸｼｮﾝの長さは、 X方向
のｾﾙの最大数Max (100) または、ｻﾌﾞｾｸｼｮﾝｻｲｽﾞの最大値になるまで長くなり、こ
の両者のどちらかはじめに該当した値がもう一方の角や不連続部に近づくまで、
その長さのまま使われます。

しかし、縁部のｻﾌﾞｾｸｼｮﾝがどんなに長くても、それは必ず 1 ｾﾙ分の幅であること
を覚えていてください｡これは縁から金属導体の内側へいくに従い、電流密度が
急峻に変化するからです（これはｴｯｼﾞの特異性と呼ばれています）。

Subsection size is 1 cell by 1 cell on corner
Subsection size is 1 cell 

Interior subsections are wide 

Cell Size =

and long

wide along edge

A portion of circuit metal showing how em combines cells into 
subsections. In this case the subsectioning parameters are set to their 
default values: X Min = 1, Y Min = 1, X Max = 100 and Y Max = 100.
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縁部に非常に高い電流が流れることを正確に表現するために、縁部のｻﾌﾞｾｸｼ ｮﾝ
を 1 ｾﾙ分の幅にしてあります。しかし、電流密度は金属導体の内側にいくに従
い、ゆるやかなものになるので、内側のｻﾌﾞｾｸｼｮﾝはだんだん広くなっています｡
前述のように、ｻﾌﾞｾｸｼｮﾝの幅は 1 ｾﾙから 2 ｾﾙ分、そして 4 ｾﾙ分と広くなっていき
ます。

TIP
2つの図形の接合部や小さい重なり部があると、ｴｯｼﾞの特異性をﾓﾃﾞﾘﾝｸﾞ
するために、2つの図形の境界に多くのｻﾌﾞｾｸｼｮﾝは必要となります。
Merge ｺﾏﾝﾄﾞ (Edit ⇒ Merge Polygons) を使って2つの図形を1つにつなげる
と、必要とされるｻﾌﾞｾｸｼｮﾝ数を減らし、解析時間は短くなります。

反対に、回路により高精度にしたい領域がある場合、 Divide ｺﾏﾝﾄﾞ (Edit ⇒
Divide Polygons）を当該の点で使用して 2つの図形を作成すると、ｴｯｼﾞの
特異性をﾓﾃﾞﾘﾝｸﾞするために、強制的に解析により小さなｻﾌﾞｾｸｼｮﾝを使
うようになります。

X Min and Y Min with Edge Mesh Off

ｴｯｼﾞﾒｯｼｭｵﾌﾟｼｮﾝを “on” にしておくことは、 Sonnet のﾌﾟﾛｼﾞｪｸﾄではﾃﾞﾌｫﾙﾄ
の状態ですが、初めにｴｯｼﾞﾒｯｼｭを “off” にした場合を調べると、この
ｺﾝｾﾌﾟﾄが理解しやすいでしょう。ここでは、斜め線状の縁部のない図形
であるﾏﾝﾊｯﾀﾝ型図形についてのみ説明します。ﾏﾝﾊｯﾀﾝ型でない図形に対
してﾒｯｼｭを “off” にしても何の影響もありません。

場合によっては、図形のｻﾌﾞｾｸｼｮﾝのﾃﾞﾌｫﾙﾄ設定を変えたい時もあるで
しょう。これはｻﾌﾞｾｸｼｮﾝﾊﾟﾗﾒｰﾀの X Min、 Y Min、 X Max 、 Y Maxを使えば
できます。

縁部のﾒｯｼｭを “off”にした ﾏﾝﾊｯﾀﾝ型図形の場合、ﾊﾟﾗﾒｰﾀ X Min と Y Min 
は、縁部のｻﾌﾞｾｸｼｮﾝｻｲｽﾞを設定します。ﾃﾞﾌｫﾙﾄ設定では、 X Min と Y Min 
は 1になっています。これは、縁部のｻﾌﾞｾｸｼｮﾝｻｲｽﾞが 1 ｾﾙ分の幅である
ことを意味します。 X Min が 2に設定されると、垂直の縁に沿った
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ｻﾌﾞｾｸｼｮﾝが X方向に 2 ｾﾙ分の幅になります (61 ﾍﾟｰｼﾞの図）。これにより
ｻﾌﾞｾｸｼｮﾝの数が減り、行列のｻｲｽﾞも小さくなり、より速く解析できま
す。しかし構造体の縁や不連続部に近いところでは、電流密度は粗く
ﾓﾃﾞﾘﾝｸﾞされるので、精度も低くなってしまいます。

X min またはY min が図形の大きさより大きい場合、emは図形に合うよう
にできるだけ大きなｻﾌﾞｾｸｼｮﾝを使用します。

NOTE: ｻﾌﾞｾｸｼｮﾝのﾊﾟﾗﾒｰﾀ X Min、 Y Min、 X Max 、 Y Max はｾﾙの単位で設定されます ( mil
でもmmでもmicronでもありません )。例えば X Min = 5 というのは X方向の
最小ｻﾌﾞｾｸｼｮﾝｻｲｽﾞが 5 ｾﾙ分の大きさであるということです。

Cell Size = 

{2 Cells Wide

Y

X

{1 Cell Wide
(Y Min = 1)

(X Min = 2) 4 Cells
8 Cells

4 Cells

2 Cells

A portion of circuit metal showing how em combines cells into subsections for Manhattan 
polygons when X Min = 2 and Y Min = 1. 
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X Min と Y Minのﾊﾟﾗﾒｰﾀは大変便利なｵﾌﾟｼｮﾝですがもっと大きなｾﾙｻｲｽﾞ
を使う時には便利とはいえません。例えばｾﾙｻｲｽﾞが 10 ﾐｸﾛﾝ x10 ﾐｸﾛﾝ で、
X Min = 1、 Y Min =1 と設定された回路はｾﾙｻｲｽﾞが 5 ﾐｸﾛﾝ x5 ﾐｸﾛﾝで、X Min 
= 2 、 Y Min = 2と設定された同じ回路よりも解析時間は速くなります。両
方とも、ｻﾌﾞｾｸｼｮﾝの総数は同じですが emでは小さなｻｲｽﾞのｾﾙを使った
各ｻﾌﾞｾｸｼｮﾝの値を計算することに非常に多くの時間をかけなくてはなら
ないからです。

X Min and Y Min with Edge Mesh On

ｴｯｼﾞﾒｯｼｭを “on” にするとより正確な解析が得られるので、 Sonnet の
ﾌﾟﾛｼﾞｪｸﾄではこのｵﾌﾟｼｮﾝが “on” というのがﾃﾞﾌｫﾙﾄの状態です。ある図形
にｴｯｼﾞﾒｯｼｭを “on” にすると、最も外側よりのｻﾌﾞｾｸｼｮﾝの扱い方が変わり
ます。ｴｯｼﾞﾒｯｼｭを “ off” にして、前の例題の左から右へ進むと、
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ｻﾌﾞｾｸｼｮﾝは 2 ｾﾙ、4 ｾﾙ、 8 ｾﾙの幅になっています。ｴｯｼﾞﾒｯｼｭを “on” にする
と、同じ図形のｻﾌﾞｾｸｼｮﾝは下図のように 1 ｾﾙ、  4 ｾﾙ、 8 ｾﾙとなります。最
も外側の縁部だけが影響を受けていることにご注目ください。

前の節で述べたように、ｴｯｼﾞﾒｯｼｭの設定はﾏﾝﾊｯﾀﾝ型図形 (つまり斜め線
や曲線状の縁がないもの )にのみ影響します。ﾏﾝﾊｯﾀﾝ型でない図形の
ｴｯｼﾞﾒｯｼｭは、その図形のｴｯｼﾞﾒｯｼｭの設定が何であろうと、いつも “on” で
す。

Cell Size = 

Y

X

1 Cell by 1 Cell 4 Cells
on corner (2 * X Min)

X Min = 2 、YMin =1に設定された縁部のﾒｯｼｭが onの図形でｾﾙからｻﾌﾞｾｸｼｮﾝ
を作成する場合の回路の金属部分。縁部がﾒｯｼｭの図形では縁部のｻﾌﾞｾｸｼｮﾝは
いつも 1 ｾﾙ幅です。



Sonnet User’s Guide

64

大きな X Min や Y Min の値と一緒に使われるとこのｵﾌﾟｼｮﾝは、ｻﾌﾞｾｸｼｮﾝ
数を減らしてもなおｴｯｼﾞの特異性はそのまま維持したい時に大変有効で
す (下図参照）。これは多くの場合、精度と解析の速さの折衷案としてよ
いｵﾌﾟｼｮﾝです。

上図の場合、 X Min と Y Min は非常に大きな値に設定されており、周波
数は十分低いので、ｻﾌﾞｾｸｼｮﾝｻｲｽﾞに対応した Max. Subsection size ﾊﾟﾗﾒｰﾀ
はこの図形よりも大きくなっています。

Using X Max and Y Max for an Individual Polygon

 X Max と Y Max のﾊﾟﾗﾒｰﾀを使うと、個々の図形の最大のｻﾌﾞｾｸｼｮﾝｻｲｽﾞを
調整することができます。例えば、X Max と Y Maxが 1に下げられる
と、すべてのｻﾌﾞｾｸｼｮﾝは 1 ｾﾙとなります。この結果、非常に多くの
ｻﾌﾞｾｸｼｮﾝ数と非常に大きな行列となり、解析時間が長くなる原因となり
ます。従って、これは非常に高い精度が求められているか、かなりｽﾑｰｽ
な電流密度表示が必要な小規模な回路でのみ行うべきです。
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NOTE: X Max または Y Max で指定された最大のｻﾌﾞｾｸｼｮﾝｻｲｽﾞは、 Max. 
Subsection Size ﾊﾟﾗﾒｰﾀで計算されたｻｲｽﾞよりも大きい場合、  Max. 
Subsection Size ﾊﾟﾗﾒｰﾀが優先されます。最大ｻﾌﾞｾｸｼｮﾝｻｲｽﾞについては、
68ﾍﾟｰｼﾞの"Setting the Maximum Subsection Size Parameter"で説明さ
れています。

Using the Speed/Memory Control 
 Speed/Memory Control 機能は回路のｻﾌﾞｾｸｼｮﾆﾝｸﾞを調整することによっ
て、解析で使用するﾒﾓﾘを調整することができます。ﾒﾓﾘを多く設定する
と、より正確な答えが算出されますが、大抵は計算時間が長くなりま
す。反対に、ﾒﾓﾘを少なく設定すると計算は早くなりますが、精度は劣
ります。

 Speed/Memory Control機能を使うには次のようにします。

1 Project editor のﾒｲﾝﾒﾆｭｰから Analysis ⇒ Setup を選択します。

2 表示された Analysis Setup ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽで、 Speed/Memory ﾎﾞﾀﾝをｸﾘｯｸし
ます。

3 表示された Analysis Speed/Memory Control dialog ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽで、所望
の設定を選びます。
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Speed/Memory Control機能には 3つの設定が用意されています。 Fine/Edge 
Meshing、 Coarse/Edge Mesh、 Coarse/No Edge Meshingです。Fine/Edge 
Meshingはﾃﾞﾌｫﾙﾄの設定で、57 ﾍﾟｰｼﾞの "Default Subsectioning of a Polygon"
にその説明があります。以下に例題を示します。ここで再び、この設定
が最も精度のある答えとはなりますが、それには最高のﾒﾓﾘと計算時間
がかかることにご注目下さい。

2つめのｵﾌﾟｼｮﾝは Coarse/Edge Meshです。この設定はしばしば計算速度と
精度のﾊﾞﾗﾝｽが取れています。この設定が使用される時にはすべての図
形の Xmin と Ymin は大きな数に設定されます。たいてい、 50の値が使わ
れ、ｴｯｼﾞﾒｯｼｭは onに設定されます。下図はこの設定を行った典型的な
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回路です。図形の縁は小さいｻﾌﾞｾｸｼｮﾝ、図形の内側部分は非常に大きな
ｻﾌﾞｾｸｼｮﾝになっていることにご注目ください。これは、大きな Xmin と
Yminが設定されているからです。

最後の設定は Coarse/No Edge Meshingです。この設定では、すべての図
形に大きな Xmin/Ymin が設定され、ｴｯｼﾞﾒｯｼｭは “off” です。これは最も
早い解析時間となりますが、精度は一番悪くなります。下図はこの
ｵﾌﾟｼｮﾝを使った典型的な回路のｻﾌﾞｾｸｼｮﾆﾝｸﾞです。
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Setting the Maximum Subsection Size Parameter
 Max. Subsection Size ﾊﾟﾗﾒｰﾀは波長あたりのｻﾌﾞｾｸｼｮﾝに換算した最大
ｻﾌﾞｾｸｼｮﾝｻｲｽﾞを設定することができますが、ここで波長とは近似的に解
析を始める周波数を指します。解析の最高周波数は波長の計算に使用さ
れます。この値はﾓﾃﾞﾙ全体に対する設定で、回路のすべての図形の
ｻﾌﾞｾｸｼｮﾆﾝｸﾞに適用されます。

ﾃﾞﾌｫﾙﾄの波長あたり 20 ｻﾌﾞｾｸｼｮﾝがどの解析にもよいでしょう。これはつ
まり、最も大きいｻﾌﾞｾｸｼｮﾝｻｲｽﾞで、解析の最高周波数において 18 度にあ
たるという意味です。この数を大きくすると最大ｻﾌﾞｾｸｼｮﾝが１ｻﾌﾞｾｸｼｮﾝ
= 1 ｾﾙという限界にまで減ります。

より正確な解析を求めるためにこのﾊﾟﾗﾒｰﾀ値を小さくしたいと思われる
かもしれません。例えば、ｻﾌﾞｾｸｼｮﾝｻｲｽﾞを 20から 40 に変えると、最大
ｻﾌﾞ ｾｸｼｮﾝ ｻｲｽﾞが 1/2になり、その結果より正確な（しかし解析時間は長
くなります）解析となります。ｸﾘﾃｨｶﾙでない領域でより小さなｻｲｽﾞのｻﾌﾞ
ｾｸｼｮﾝを使うと、解析時間は長くなりますが精度にはあまり影響はない
ということを念頭に置いてください。

このﾊﾟﾗﾒｰﾀを使用するもう１つの場合は、 current density viewerを使って
かなりｽﾑｰｽな電流分布を求めたい時です。ﾃﾞﾌｫﾙﾄ値の 20を使うと内部の
大きなｻﾌﾞｾｸｼｮﾝは電流分布を “変化の見やすい ”状態にします。この
ﾊﾟﾗﾒｰﾀを大きな値にすると、ｻﾌﾞｾｸｼｮﾝは皆、たった 1 ｾﾙの大きさになっ
てしまい、ｽﾑｰｽな電流分布になります。これによっても解析時間に大き
く影響してきます。

Max. Subsection Size ﾊﾟﾗﾒｰﾀは project editorで Analysis ⇒ Advanced 
Subsectioningを選択すると Advanced Subsectioning Controls が出てきます
のでそのﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの中で設定します。

Defining the Subsectioning Frequency
ｻﾌﾞｾｸｼｮﾆﾝｸﾞのﾊﾟﾗﾒｰﾀMax. Subsection Sizeは、回路のすべての図形に適用
され、これは波長あたりのｻﾌﾞｾｸｼｮﾝ数として定義されます。通常は、最
高解析周波数がその波長の決定に使用されます。しかし最高周波数は、
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project editorの Advanced Subsectioning Control ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの中で
Subsectioning Frequency   ｵﾌﾟｼｮﾝを使用して変更することができます。この
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽは project editorのﾒｲﾝﾒﾆｭｰから Analysis ⇒ Advanced  
Subsectioningを選択してｵｰﾌﾟﾝします。ｻﾌﾞｾｸｼｮﾆﾝｸﾞの周波数の定義にどの
ｵﾌﾟｼｮﾝが使用されているかについては、Advanced Subsectioning Control 
ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの Help ﾎﾞﾀﾝをｸﾘｯｸしてご覧ください。

選択されたｵﾌﾟｼｮﾝで定義された周波数は、ここでは、解析の最高周波数の代
わりに最大ｻﾌﾞｾｸｼｮﾝｻｲｽﾞを決定します。従って、いくつかの解析では、最高
周波数とは違う周波数で、同じｻﾌﾞｾｸｼｮﾝが使われることもあります。

Conformal Mesh Subsectioning
ｺﾝﾌｫｰﾏﾙﾒｯｼｭは、斜め線または曲線状の図形の縁部を持つ回路の解析に必
要なﾒﾓﾘと時間を大幅に減らすことのできる技法です。ｺﾝﾌｫｰﾏﾙﾒｯｼｭについ
ての説明と、その使用方法については 169 ﾍﾟｰｼﾞの "Conformal Mesh "を
ご覧ください。この章では、ｻﾌﾞｾｸｼｮﾆﾝｸﾞに与えるｺﾝﾌｫｰﾏﾙﾒｯｼｭの効果に
ついてのみ説明します。

この技法は、斜め線や曲部の輪郭を持つｾﾙ列をまとめ、その輪郭に沿っ
て長いｻﾌﾞｾｸｼｮﾝを作ります。階段状の充填は X方向と Y方向には非常に
小さなｻﾌﾞｾｸｼｮﾝとなるのに対し、ｺﾝﾌｫｰﾏﾙﾒｯｼｭは図形に沿ったわずかな
ｻﾌﾞｾｸｼｮﾝとなります。下図はｺﾝﾌｫｰﾏﾙｾｸｼｮﾝの実際の金属導体と、階段状
充填を使った同じｾｸｼｮﾝを示しています。

Conformal section Staircase Fill
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ｺﾝﾌｫｰﾏﾙなｾｸｼｮﾝは、標準のｻﾌﾞｾｸｼｮﾝ同様、ｾﾙから構成されているので、
実際の金属導体は下図のように、図がｽﾑｰｽな縁の時には依然 "ギザギザ
"した縁があります。しかし、このｾｸｼｮﾝはｺﾝﾌｫｰﾏﾙﾒｯｼﾝｸﾞのおかげでか
なり大きくすることができます。基礎となるｸﾞﾘｯﾄﾞを十分に小さくして
余分なﾒﾓﾘと解析時間を生じさせずに、正確に回路の寸法を変更するこ
とができます。この大きなｾｸｼｮﾝでは、解析時間が早くなり、ﾒﾓﾘも少な
くてすみます。

標準のｻﾌﾞｾｸｼｮﾆﾝｸﾞは、線路幅に渡って正確な電流分布をﾓﾃﾞﾘﾝｸﾞするた
めに、多くのｻﾌﾞｾｸｼｮﾝが必要です。ｺﾝﾌｫｰﾏﾙなｻﾌﾞｾｸｼｮﾝはこの分布を
ｻﾌﾞｾｸｼｮﾝの中に内蔵します。Sonnetのｺﾝﾌｫｰﾏﾙﾒｯｼﾝｸﾞは自動的にｺﾝﾌｫｰﾏﾙな各
ｾｸｼｮﾝの縁部の高い電流を含みます。特許を得た Sonnetのこの機能はﾕﾆｰｸな
ものです (U.S. Patent No. 6,163,762 issued December 19, 2000.)

標準のｻﾌﾞｾｸｼｮﾆﾝｸﾞとｺﾝﾌｫｰﾏﾙﾒｯｼｭを使った回路の例を以下に示します。
左の回路は標準のｻﾌﾞｾｸｼｮﾆﾝｸﾞ（階段状充填 )を使って表示されていま
す。回路の曲部がある部分へのｺﾝﾌｫｰﾏﾙﾒｯｼﾝｸﾞが右に表示されています。
図形の曲部に対しては、ｺﾝﾌｫｰﾏﾙﾒｯｼｭは標準のｻﾌﾞｾｸｼｮﾆﾝｸﾞが使用された
時よりも、かなり少ないｻﾌﾞｾｸｼｮﾝを使います。
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Conformal Mesh Subsectioning Control

ある図形にｺﾝﾌｫｰﾏﾙﾒｯｼｭを適用する時、より正確なｼﾐｭﾚｰｼｮﾝを行うため
に、ｺﾝﾌｫｰﾏﾙなｾｸｼｮﾝの最大の大きさを制限することができます。
ｺﾝﾌｫｰﾏﾙなｾｸｼｮﾝのﾃﾞﾌｫﾙﾄの長さは、ｻﾌﾞｾｸｼｮﾆﾝｸﾞの周波数で波長の 1/20 
です。ｻﾌﾞｾｸｼｮﾆﾝｸﾞの周波数については、68 ﾍﾟｰｼﾞの "Defining the 
Subsectioning Frequency"をご覧ください。

ｺﾝﾌｫｰﾏﾙなｾｸｼｮﾝに最大の長さを設定するには、次のようにします。

1 所望の図形を選択します。

選択された図形が強調表示されます。

2 Modify ⇒ Metal Propertiesを選択します。

Metalization Properties ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽがｵｰﾌﾟﾝします。

3 ﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽの Conformal Mesh Subsectioning Controls 欄の Maximum 
Length ﾁｪｯｸﾎﾞｯｸｽをｸﾘｯｸします。

右側の Length text 入力ﾎﾞｯｸｽが選択可能になります。Fill Typeに
Conformalが選択された時にのみこのﾁｪｯｸﾎﾞｯｸｽは選択可能になることに
注意してください。

4 ﾃｷｽﾄ入力ﾎﾞｯｸｽに所望のMaximum Length ( 最大の長さ )を入力します。

OK ﾎﾞﾀﾝをｸﾘｯｸしてﾀﾞｲｱﾛｸﾞﾎﾞｯｸｽをｸﾛｰｽﾞし、変更事項を適用します。

Conformal Meshについての詳しい説明は 169 ﾍﾟｰｼﾞの第 11章 "Conformal 
Mesh "をご覧ください。Conformal Meshのﾁｭｰﾄﾘｱﾙは Sonnet Supplemental 
Tutorialsの 63 ﾍﾟｰｼﾞの第 4章 "Conformal Mesh Tutorial "にあります。


